
Iconizer Pro User’s Manual
Written by Narattaphol Charoenphandhu

This software is a shareware of US$ 15.00, see Registration part below.
Your comment and suggestion are welcome.

• Introduction

Iconizer Pro is an application developed for generating a set of 32 bit (16
millions, full colors) icons from any pictures.  This feature is normally used
for creating a background of CD, folder or other container windows.  The
output icons can also be viewed on any Mac OS, including Mac OS X, but
Mac OS 8.5 or higher is required to view 32 bit color.

• System Requirements

Computer :
-An Apple Macintosh or Mac OS-compatible computer with fast PowerPC
Processor, and a hard disk with at least 3 MB free space.
-Monitor must be set to Millions of Colors, unless you cannot view 32 bit
icons, including 32 bit icon of Iconizer Pro application (You should see red
yellow, and magenta color in the icon of Iconizer Pro application.).

RAM Requirement :
At least 5 MB free RAM with Virtual Memory on (6 MB free with Virtual
Memory off) for managing non-masked picture with as large as 300 icons
(640x480 pixel).  If the engine fails to run or produces an incomplete result,
please increase free memory from the application’s Get Info window.

Software Requirements :
-Mac OS 8.6 or later for Mac OS 9 version
-Mac OS X 10.1.5 or later for Mac OS X version.
-QuickTime 4.0 or later

• Get Start

1. Prepare you target image from image editing application (Iconizer Pro is
not an image editor). Image width and height should be x times of 32 oth-
erwise Iconizer Pro will add a border to fill the gap (see Border section).
2. Launch Iconizer Pro application.



3. Import picture. You have 5 ways to import a picture, i.e

1. Use Select Picture command

2. Paste picture to preview area

3. Drag picture file or picture clipping to this box

4. Press this icon

5. Drop a picture from other
applications (not a picture
file) here.



4. Select destination folder.  Destination folder must be a blank folder or
blank volume (including hard disk, RAM disk and disc image). You have
three methods to select destination.

5. If you want to create blank icons (transparent icons, only their name are

1. Use this command

2. Drag empty folder to this area

3. Press this icon



visible) too, enter amount of blank icons in the text field.  You can also cre-
ate blank icons on-the-fly by pressing the Watch Icon, select Create Blank
Icon command from Special menu or Option+click on Iconize button.

6. You can clear preview area by pressing the Trash icon or using Edit menu
command.  This command also clears "Create Blank Icon" text field.

7. Finally, press Iconize button or use File menu command to make icons.

Enter amount of blank icon here

Use this command to create
blank icons

Watch icon

Trash icon



• Iconizer Pro Extra

1. Show clipboard : Select Edit menu and choose Show Clipboard.

2. About window : Since Iconizer Pro is powered by Naratt Graphics Lib
and Naratt IconService Lib which are parts of Add Items Pro, the About
window shows the informations of Add Items Pro-emulating engine.

Show processor type and memory usage



3. Navigation Service : Iconizer Pro fully supports Navigation Service 2.0
or higher (Part of Mac OS 9).  If you are running Mac OS 8.6, some fea-
tures may not work properly.  Window of Navigation Service is showed as
the following.

4. Contextual Menu : Contextual menus will be shown when press Control
button and click mouse cursor on the file’s name displayed in file-dropping
areas (depicted next page). They allow to open item, reveal item in Finder,
get Finder informations and create preview picture for standard Open/Save
dialog or Navigation Service file browser (see details in next topic).



• Picture Preview Process

Preview process is a useful feature of an old Open/Save dialog as well as a
modern Open/Save dialog or the Navigation Service.  You can preview the
pictures by press “Show Preview” button in Open/Save dialog.  Normally,
the pictures which can be previewed must have special codes that allow
QuickTime and QuickTime Power Plug to access and display.  If the pic-
tures do not have the preview codes, those softwares must have their own
preview methods, which are risk and slower especially when the pictures

Support Control-Click (Contextual Menu)

Support Control-Click (Contextual Menu)

Show Info

Zoom buttons



are very large, to display preview.  Thus, most softwares do not have their
own global preview processes.  If you select pictures which contain no pre-
view code, the result box will show the text “No preview available.”.  To
solve this problem, you must incorporate the preview codes to the pictures
by using special graphic programs, e.g. PhotoShop, GraphicConverter and
Iconizer Pro 1.3.3 or later.

The method of adding preview codes with Iconizer Pro is very easy.
After you import your target picture into the main window :

1. Press Control key and click on a picture’s name in “Picture File :”
path area to bring up the contextual menu (depicted on next page).

2. Choose menu command “Create Preview”.  
Please note that if your picture already have the preview codes, the

menu command “Delete Preview” will appear instead.

Result Box



• Clean Up Icon Set

Iconizer Pro 1.3.4 or later allows users to clean up or rearrange the icon set
which is accidentally deranged.  Normally, clean up method is faster than
creating a new icon set.  Please note that the folder that you want to clean
must contain only Iconizer Pro-generated icons. All icons must also have
embedded Iconizer Pro-generated system registry.  If your icon set is creat-
ed by the previous version of Iconizer Pro or your icons are “Blank Icons”,
you must add “Clean Codes” by using Clean menu command “Embed
Codes”.  During rearrangement, selected folder is not necessary to be set
view to “by icon”.  It can be viewed “by list” or “by button” while the
process is running.  After switching to view “by icon” (Use Finder’s View
menu command), all icons will be automatically rearranged to their defined



position.  The arrangement process will commence after you choose “Clean
Up Icon Set”.  Users can remove “Clean Codes” from the icon set by using
“Remove Codes”.  To show the coded items, choose “Show Coded Items”.

Tip : 
- Before adding “Clean Codes” to the icon set, please make sure that your
icon set has been already arranged in its proper position, otherwise the
undesirable registry will be embedded.
- To retain icon position after moving, you should Select All icons before
move them.

For advanced users : 
you can command Iconizer Pro to rearrange icon set generated by other
iconizing softwares.  However, the method is not simply.  Before add the
“Clean Codes” to all icons, you must change type and creator of icons to
“rsrc” and “AITP”, respectively.  To change type and creator, you may
write your own converter or use some third party softwares which are avail-
able to download at several archives. If you want to write the automatic
converter by yourselves the code is very simple as below :

OSErr ChangeTypeAndCreator (FSSpec *spec)
{

FInfo info; //Structure FInfo
OSErr err;
err=FSpGetFInfo(spec,&info);
info.fdType='rsrc';
info.fdCreator='AITP';
err=FSpSetFInfo(spec,&info);
return err;

}

Once icons’ type and creator are set correctly, you can rearrange this icon



set in the same manner as you do with Iconizer Pro-generated one.  You
must perform this tip with your own risk.

• White Icons Management

Iconizer Pro1.3.6 or later allows user to manage the icons which display
absolute white color.  Why we need this tool? Because white icons have the
same color as the window background, it is worthless to include white icons
in your container windows. You have two ways to manage white icons as
the following

1. Ask Iconizer Pro to select white icons by using Show White Icons com-
mand from Special menu.  This allows you to manage them manually.

2. Ask Iconizer Pro to automatically move all white icons to Trash by using
Trash White Icons command from Special menu.  You can permanently
delete them by emptying trash or change your mind and restore the icon set
by moving trashed items back to their original folder and using clean up
method to restore their positions as previously described.

• Border of Icon Set

To create a proper icon set, image width and height should be x times of 32
otherwise Iconizer Pro will add a border to fill the gap, as previously men-
tioned.  Iconizer Pro 1.4.3 or later provides three types of borders:

1. Border Mask : This type is a transparent border, i.e. no extra white area
appears.  This option is activated by default.  To deactivate this type, dese-
lect Border Mask (Command+K) from Edit menu.

2. White Border Default : This type is an old default white border in
Iconizer Pro 1.4.2 or older.  The white border will appear in right and bot-



tom parts of the image.  To activate this type, deselect both Border Mask
and Center Image (Command+G) from Edit menu.

3. White Border Center : This is a new white border.  The image will be
placed centrally.  To activate this type, select Central Image and deselect
Border Mask from Edit menu.

• View Options

Iconizer Pro 1.5.5 or later has three view options, i.e. View Image, View
Mask and View Composite (See picture above). User can use "Tab" key to
change current View Option. 

- View Image displays only a source image on the preview area.
- View Mask displays only a mask layer on the preview area.
- View Composite displays a masked source image on the preview

area.

Normally, the Mask layer is a black rectangle.  If you want to create your
own Mask (Custom Mask), please see details and a sample in the "Install
First" folder inside the Iconizer Pro package.

Note:
View Option command is not only a view switching command, but is also
a Mask updating command, i.e. if users selected one of the View Option
commands, Iconizer Pro will update the Mask of that picture and display
that picture and/or Mask as described by the selected View Option com-
mand.



• Saving Preferences

Iconizer Pro 1.5.5 or later has advanced users-defined preferences.  This
preferences will be saved automatically after the application is quitted.
However, I strongly recommend to leave all preferences as their default set-
tings. There are 8 preferences, i.e.

1. Border Mask option of Edit menu
2. Center Image option of Edit menu
3. View Options : View Image, View Mask and View Composite
4. Copy Address option : allow to copy the address to clipboard.

5. Close Window option
6. File formats inside "Choose Picture" dialog
7. "Generate single icon" inside "Save Blank Icon" dialog.
8. "Show visible items only" option

• Changing Get Info Texts

Registered users can change the Get Info texts of the icons’ Get Info win-
dows (see picture).  Therefore, registered users can add their names, com-
panies’ names or any texts to those windows.  To use this feature,



1. Create a text file with SimpleText or any text-editing softwares.
2. Type the text that you want to place on the Get Info windows.  The

text should contain 250 characters or shorter.
3. Save the file.
4. Import the text by using “Select Get Info Text” command of the

File menu.
5. Select the text file which you have already created.
6. The text will appear on every icons until you quit the Iconizer Pro.
7. If you want to use the default Get Info text, select the “Use Default

Get Info” command of the File menu.

• Add Items Pro Service Lib

In 1999, the element of Add Items Pro was created as a Mac OS shared



library which includes a lot of useful commands.  In the following year, I
incorporated Add Items Pro Service Lib 1.0 into my two softwares, Add
Items Pro 1.0 and Navigation Service Preview Maker.  The former, cur-
rently version 1.5,  is a tool for managing items of the customised folders,
usually plugin folders, as Extension Manager does.  The latter has an exten-
sion and a control panel.  Both allow to create, delete, copy, paste, get pixel
info of or edit preview picture for Navigation Service dialog box.  If
Navigation Service Preview Maker is installed, the forth button will appear
on the upper right corner of Navigation Service dialog box.  Add Items Pro
Service Lib is embedded into Iconizer Pro since version 1.3.

• Registration

Iconizer Pro 1.4.1 or later is a shareware.
Single user license US$ 15.00
Site license US$ 120.00
World-wide site license US$ 1000.00

Purchase online by credit card, cash, check or money order at:
http://order.kagi.com/?69A

Please note that
1.Shareware or freeware developers can pay single user license.
2.Commercial users who distribute CDs with Iconizer Pro-generated icons
inside: 1. with acknowledgement to Iconizer Pro in Read Me can pay sin-
gle user license 2. without acknowledgement must pay site license.
3.Commercial users who want to bundle Iconizer Pro with their products,
e.g. CD-RW manufacturers, must pay world-wide site license price.

I will send a registration key by e-mail within 3 days after your payment.
The Get Info window of each icon generated by unregistered version will
show an “Unregistered” message (see picture below).  

• FAQ

1. Why I obtain some white icons when source image is extremely large?
This is a minor bug which the element of problem may reside in the system
itself.  If the picture is, approximately, larger then 900 icons, you may
observe some white icons.  These white icons are not corrupted and can be



displayed normally if you “strongly” refresh them, e.g. open their Get Info
windows and check then uncheck “Locked” check box.

2. Why are my icons not properly arranged?
Check you Finder's “View Options” of your destination folder.  The "Icon
Arrangement" option must be set to "none".  To access this option, choose
View Options command from Finder's View menu.

3. Why don’t Clean Up, White Icon or iconizing engines work when there
are non-icon files or folders in the destination?
Iconizer Pro normally modifies the properties of destination folder.  It also
checks for some particular internal codes of existing files.  Therefore, I do
not want Iconizer Pro to touch your files to avoid several kinds of damages



4. Why icon set built by version 1.3.6 or newer have white bars inside the
graphics?
This problem is very rare. It is caused by some third party softwares which
can modify Mac OS routines, e.g. Natural Order 1.4 and Title Free 1.3.2.

If you have other problems or questions, please mail to me or see:
http:// www.naratt.com/troubleshooting.html

• Distribution

You can freely distribute a complete package of Iconizer Pro if you want
but not with commercial products, e.g. CD-R hardwares (see Registration).

• Contact Informations

WebSite : http://www.naratt.com
WapSite : http://www.naratt.com/wap.wml
E-mail : naratt@naratt.com

You can also access these informations by using “Contact Information”
command from Iconizer Pro’s Apple Menu or Help Menu.

• Disclaimer

My effort has been made to test this application and its components to
ensure their perform as expected, therefore I will not be held responsible for
any consequential, incidental, direct or indirect damages through the use of
this software.

• Version History
To see the complete list of version history, go to:
http://www.naratt.com/history.html

©1998-2003 Narattaphol Charoenphandhu
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